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Welcome to CCH Coolbar! 
 

CCH, a Wolters Kluwer business, welcomes you to CCH Coolbar. 

The Installation Guide details the installation instructions and setup information for CCH Coolbar. Please 
refer to the Table of Contents to locate the step-by-step installation instructions. 

It is our commitment and goal to continue to improve the overall value of the products and services we 
provide. If we can be of assistance to you, please let us know. You can reach us at 1-800-PFX-9998.  
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CCH Coolbar Installation and Setup Instructions 
Installing and setting up the CCH Coolbar add-on to ProSystem fx Practice Management includes setting up 
global firm information and then installing CCH Coolbar components on employee workstations. 

FIRM Setup: Set global CCH Coolbar options for your firm. 

1. Install ProSystem fx Practice Management version 2009.90.01 or higher on the server. 

2. Run versiondb.exe and select the CCH Coolbar global setup options for the firm. 

3. Set security options in ProSystem fx Practice Management for firm employees who will use CCH 
Coolbar. 

4. Activate employees in ProSystem fx Practice Management for CCH Coolbar. 

 

WORKSTATION Setup: Install CCH Coolbar components on designated workstations. 

1. Set up individual workstations. 

2. Start CCH Coolbar in Outlook. 

 

Note: CCH Coolbar honors the ProSystem fx Practice Management security established for the firm 
employees (Administration/Firm/Security Setup). For example, if an employee does not have Contact 
Management/Client AR privileges, A/R review features will be disabled in the Client Details section of the 
CCH Coolbar DataCenter. Not having security for the Clients tab in Reports disables A/R review in the 
Finance section of the DataCenter. CCH Coolbar does not honor client trims from ProSystem fx Practice 
Management. If your firm uses ProSystem fx Practice Management client trims, they will not be available in 
CCH Coolbar. 

 

CCH Coolbar FIRM Setup: 
Set global options for your firm 

Step 1: Install ProSystem fx Practice Management version 2009.90.01 or higher on the server 

To use the CCH Coolbar add-on, install ProSystem fx Practice Management 2009.90.01 or higher on the 
server. See the Release Bulletin or Installation Guide for details on installing. 
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Step 2: Run versiondb.exe and select the CCH Coolbar global setup options for the firm. 

Set up the CCH Coolbar options for the firm. Database and folder options you set up here will be GLOBAL 
defaults for all firm employees who are activated to use CCH Coolbar. 

To run versiondb.exe 

1. Select Run on the Start menu. Browse to your cpas\vpm\updates directory (on the server where 
ProSystem fx Practice Management was installed). Select versiondb.exe to set up the new database for 
CCH Coolbar and set folder defaults. Click Open. Click OK. 

 

2. Click the File menu to display the CCH Coolbar setup options: CCH Coolbar Data Creator and CCH 
Coolbar Folder Setup. 

To run the CCH Coolbar Data Creator 

1. Select CCH Coolbar Data Creator from the File menu in versiondb.exe. 
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2. On this first window, connect to your active ProSystem fx Practice Management SQL Server. Your 
ProSystem fx Practice Management Database Credentials default from the pmnet.ini file. 
 
Server name: This is the SQL Server Name entered when installing ProSystem fx Practice 
Management. We recommend that you accept this default from the pmnet.ini file. 
 
Authentication: SQL Server Authentication defaults. We recommend that you accept this default. 
 
Username:  Accept the default for Username. 
 
Password: Accept the default for Password. 
 
Database: This is the SQL DB Name entered when installing ProSystem fx Practice Management. We 
recommend that you accept the default from the pmnet.ini file. 

3. Click Next to continue. 

4. In Step 2, select the data storage type. 

 

 

 

 

 

 

 

 

 

 

 

5. Update Active Practice Management Database (Default) is selected by default. This selection 
updates the active ProSystem fx Practice Management database (selected in Step 1) to run with CCH 
Coolbar. We recommend that you accept the default. 
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6. If you do not want to update the active database, select Create new DataStore and enter the new 
dedicated database name. This option should only be used if your firm has a large WAN with multiple 
databases. 

 

 

 

 

 

 

 

 

 

 

 

7. Click Next to continue. 

8. Use the final window to build the CCH Coolbar database. 

 

 

 

 

 

 

 

 

 

 

 

9. Click Process to complete this step.  A list of commands displays on the window as the CCH Coolbar 
database is created from information in your ProSystem fx Practice Management database. 
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To run the CCH Coolbar Folder Setup 

1. Now return to the File menu in versiondb.exe and select CCH Coolbar Folder Setup. 

 

 

2. Your ProSystem fx Practice Management Database Credentials default again from the pmnet.ini file. 
 
Server name: This is the SQL Server Name entered when installing ProSystem fx Practice 
Management. We recommend that you accept this default from the pmnet.ini file. 
 
Authentication: SQL Server Authentication defaults. We recommend that you accept this default. 
 
Username:  Accept the default for Username. 
 
Password: Accept the default for Password. 
 
Database: This is the SQL DB Name entered when installing ProSystem fx Practice Management. We 
recommend that you accept the default from the pmnet.ini file. 
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3. Click Login. 

 

 

 

 

 

 

 

 

 

 

 

 

4. All CCH Coolbar folder settings are stored locally on your workstation. This is a GLOBAL setting which 
will be mirrored for all firm employees activated to use CCH Coolbar. 

5. CCH Coolbar contains information for four modules: ProSystem fx Practice Management Clients, 
Business Affiliates, Leads, and Referrals. The first folder setting displays for the Clients module. 

6. Select the folder where you want to store file attachments (Files) and incoming and outgoing linked 
emails (Mail). In Step 4 you can decide whether or not you want to enable email storage in CCH Coolbar 
for the firm. 

7. Select the folder where you want to store links to ProSystem fx Practice Management Clients and Client 
Contacts (Contacts) in CCH Coolbar. 

8.  If you want to create a new subfolder in the path, select the folder (where you want to add the new 
subfolder) in the list of Default Subfolders. 
 
Click the New link and enter the name of the subfolder to add. Then click OK to return to the Set 
Folder Settings window. 

 

 

 

 

9. Click Save to save the settings for the Clients module. 
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10. Click the Module drop-down to display the full list of modules.  

 

 

 

 

 

 

 

 

 

 

 

 

11. Select each of the remaining modules, starting with Business Affiliates. 

 

 

 

 

 

 

 

 

 

 

 

 

12. Select the folder where you want to store file attachments (Files) and incoming and outgoing linked 
emails (Mail). In Step 4 you can decide whether or not you want to enable email storage in CCH Coolbar 
for the firm. 
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13. Select the folder where you want to store links to ProSystem fx Practice Management Business Affiliates 
and Business Affiliate Contacts (Contacts) in CCH Coolbar. 

14.  If you want to create a new subfolder in the path, select the folder (where you want to add the new 
subfolder) in the list of Default Subfolders.  
 
Click the New link and enter the name of the subfolder to add. Then click OK to return to the Set 
Folder Settings window. 

15. Click Save to save the settings for the Business Affiliates module. 

16. Click the Module drop-down again and select Leads. 

 

 

 

 

 

 

 

 

 

 

 

 

17. Select the folder where you want to store file attachments (Files) and incoming and outgoing linked 
emails (Mail). In Step 4 you can decide whether or not you want to enable email storage in CCH Coolbar 
for the firm. 

18. Select the folder where you want to store links to ProSystem fx Practice Management Leads and Lead 
Contacts (Contacts) in CCH Coolbar. 

19.  If you want to create a new subfolder in the path, select the folder (where you want to add the new 
subfolder) in the list of Default Subfolders.  
 
Click the New link and enter the name of the subfolder to add. Then click OK to return to the Set 
Folder Settings window. 

20. Click Save to save the settings for the Leads module. 
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21. Click the Module drop-down again and select Referrals. 

 

 

 

 

 

 

 

 

 

 

 

 

22. Select the folder where you want to store file attachments (Files) and incoming and outgoing linked 
emails (Mail). In Step 4 you can decide whether or not you want to enable email storage in CCH Coolbar 
for the firm. 

23. Select the folder where you want to store links to ProSystem fx Practice Management Referrals 
(Contacts) in CCH Coolbar. 

24.  If you want to create a new subfolder in the path, select the folder (where you want to add the new 
subfolder) in the list of Default Subfolders.  
 
Click the New link and enter the name of the subfolder to add. Then click OK to return to the Set 
Folder Settings window. 

25. Click Save to save the settings for the Referrals module. 

26. Once you have completed the CCH Coolbar setup and have returned to the versiondb window, click 
Cancel. It is not necessary to click the Continue button and update the database if the firm is already 
running the latest version. 
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Step 3: Set security options for firm employees who will use CCH Coolbar 

Once you have completed Steps 1 and 2, open ProSystem fx Practice Management to complete the setup and 
activate the firm employees who will use CCH Coolbar. 

1. Open ProSystem fx Practice Management and select Administration. 

2. Select Security Setup from the Firm menu in Administration. 

 
 

3. Select to change security for all employees, or select each firm employee who will be using the CCH 
Coolbar add-on. 

4. Scroll through the Administration Privileges section of the security list to the Employee – CCH 
Coolbar Setup option check box. By default, this option is set to No. Select the Yes check box to 
activate the Employee Coolbar Setup option on the navigation bar in Administration. You will use this 
option in the next step to grant access to specific employees for CCH Coolbar. 

5. Click Close and continue to Step 4. 
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Step 4: Activate employees in ProSystem fx Practice Management for CCH Coolbar 

 
 

Use this window in ProSystem fx Practice Management (Administration) to give firm employees rights to 
access the CCH Coolbar add-on. You can also select to enable email storage in CCH Coolbar. 

1. In Administration, select Employee Coolbar Setup on the navigation bar under Employees. 

2. The list displays the employee name, employee code, status, and office. Click any column heading to sort 
the list by that column. 

3. Select the check box for the employees who will have access to CCH Coolbar. The number of licenses 
and the number of selected employees displays for reference. 

4. Decide if you want to enable email storage within CCH Coolbar, linking emails and attachments to 
Practice Management clients, business affiliates, leads, and referrals. This is a firm-wide decision. To 
enable email storage, click the Enable Email Storage check box. You can always return here to enable 
this feature (or turn it off). If you select to enable email storage, additional email options display on the 
CCH Coolbar. 

5. Once you’ve selected all employees, and decided whether to enable email storage, click the [X] in the 
upper-right corner to close the window and save your selections.  

6. You have now finished setting up CCH Coolbar for your firm. 
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CCH Coolbar WORKSTATION Setup: 
Install CCH Coolbar components on designated workstations 

Step 1: Set up individual workstations 

If you have not already selected to install CCH Coolbar components in Workstation Setup, follow these 
instructions for each workstation on which you will run CCH Coolbar.  

If you add workstations and plan to use CCH Coolbar on them, remember to run Workstation Setup on 
these new workstations as well. 

If you have already run Workstation Setup and selected to install CCH Coolbar components at that time 
(for each workstation using this add-on), skip this step. 

1. Shut down everything that is running on the workstation, and exit all applications. 

 Select Run from the Start menu. Click Browse and select the drive where the application was installed 
(for example, f:\cpas\setup\vpm). 

 Select setup.exe and click Open. Then click OK on the Run window. 

2. The Install ProSystem fx Practice Management Workstation window appears.  Select Install ProSystem 
fx Practice Management Workstation. 

 

3. The Wizard checks the workstation to see if all requirements are met prior to installing. 
 
If all requirements have been met, this step is skipped and the Install window displays. 
 
If any requirements are not found, a window displays, listing the requirements and their status. 
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Click OK to install the requirements prior to running Workstation Setup. Follow the on-screen 
instructions provided by Microsoft to install the requirements on this workstation. When you have 
finished, the workstation will automatically reboot if needed. If you do not return to the ProSystem fx 
Practice Management setup window again, select setup.exe again from the …\cpas\setup\vpm 
directory on the drive where ProSystem fx Practice Management was installed. Then select Install 
ProSystem fx Practice Management Workstation. 

4. The ProSystem fx Practice Management Setup Wizard window appears.  Click Next. 

5. The License Agreement displays. Select “I accept” and click Next. 
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6. The Choose Components window displays.  

 

 Required components always install. This feature requires 50 MB on the workstation’s hard drive. 

 Select Remote if your workstation (PC or notebook) will be carried out in the field or if you plan to run 
both in-house and in the field. If you are not sure, do not select the Remote check box. You can add this 
feature later by running Workstation Setup again and choosing the option, but you cannot remove it once 
it has been chosen. This feature requires an additional 375 MB of space on the workstation’s hard drive.  

 If your firm is licensed for CCH Coolbar, the CCH Coolbar check box will be enabled. Select this check 
box if you plan to use CCH Coolbar as a ProSystem fx Practice Management add-on on this workstation.  

 Make your selections and click Install to start Workstation Setup. 

7.  The Installing window displays.  

8. A progress bar shows that the workstation is being configured.  

 A message displays when Workstation Setup is complete. 

 Click Close to complete Workstation Setup.  

 Remember to choose the CCH Coolbar component in Workstation Setup on each workstation that uses 
this add-on. 

9. Now you are ready to open CCH Coolbar on the workstation. 

 

Step 2: Start CCH Coolbar 

1. Open Microsoft® Outlook on any workstation with CCH Coolbar installed. 
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2. An Open CCH Coolbar button displays in the standard Microsoft Outlook toolbar. If the Standard 
toolbar is not enabled, you will not see the Open CCH Coolbar option, so make sure the toolbar is 
enabled. 

 

3. Click Open CCH Coolbar. 

4. Enter the same User name and Password you use when logging into ProSystem fx Practice 
Management. Remember that before a firm employee can log in to CCH Coolbar, they must have been 
activated for CCH Coolbar on the Edit Coolbar by Employee window in ProSystem fx Practice 
Management (See FIRM Setup: Step 4). 

 

 

 

 

 

 

 

 

5. If you want CCH Coolbar to remember your user name and password, select the Remember 
Credentials check box.  
 
If you select the Settings link, the Connect to Database window displays. Use this window to accept 
the credentials this workstation will use to connect to the ProSystem fx Practice Management database. 
This window is similar to the CCH Coolbar Data Creator window in setup and defaults from the 
pmnet.ini file. 

6.  Click OK to open CCH Coolbar. 

7. The CCH Coolbar opens in Outlook below the Standard toolbar. 

 

 From CCH Coolbar you can change the module (Clients, Business Affiliates, Leads, or Referrals), change 
the contact, use the DataCenter, or enter Time for ProSystem fx Practice Management, as well as using 
many other features and options. Click a button on the CCH Coolbar to open that feature. 

8. See the CCH Coolbar Help for complete information when learning how to use CCH Coolbar. The Help 
system is available from the Help menu. To begin, see the Getting Started with CCH Coolbar topic 
available in the Help system. 
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Support 
Call 1-800-PFX-9998.  Support is available Monday through Friday, 8:00 A.M. to 7:00 P.M. Central Time.  
Extended hours are available during Tax Season. 


